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"I retrieved Lotto Tracker II from your homepage, tried it, and believe 
or not it hit a small win, at once. So, I am willing to register it 

before the evaluation period runs out." - Matti Tarvainen, Finland

"Lotto Tracker is terrific. Although I don't know if it'll help me win 
the lottery (if it does, I'll send you some of the winnings), it's such 

a well-written piece of software that it's a pleasure to use."
 - Brian Kelley, Apple Wizards E-zine Shareware Columnist

"I just wanted to tell you that I think "LT2" is the best. This past 
week, I would have won 2500$ in the Canadian lotto called lotto6/49. I 
was going to use the numbers from Lt2 but at the last minute I did not 

and I lost out on 2500$. Next time I'll use LT2, you can be sure of 
that. Anyway, I love your Lt2 and you've done a great job too. Keep up 

the good work." - David Emond, Canada

"Set up is easy. In fact, this entire program is very intuitive and easy 
to use. The range of support for the various lotteries is almost 

limitless." - from a review by lottery guru Tom Rockwell

 
ZDNet Editor’s Pick 4-

star rating - Oct ‘98
Super Shareware 5-star rating - Aug ‘99

MacMadness Software Pick - 

May ‘99

Visit the Lotto Tracker II web site at:
http://www.ggonsalves.com/lotto.html

for FREE updates and up-to-date results for your favorite lotto game.
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Introduction

Welcome!
Thanks for using Lotto Tracker II (LTII). I've designed LTII to make playing the lottery more interesting 
and, hopefully, more fun. It allows you to keep track of winning lotto numbers and then uses this 
information to provide win statistics and to suggest numbers to use in upcoming draws, using its internal 
probability logic. LTII will provide you with statistics, graphs and other tools for analyzing past results, it 
will suggest number combinations for you to play and even check its suggestions against the actual result. 
It can track up to 300 lottos of almost any type (from 5/20 to 10/99) simultaneously. It can import results 
and export both results and statistics from and to several formats. And it does all this using a friendly and 
intuitive user interface that’s (hopefully) easy to understand.

A note of caution. When using LTII always remember that the odds of winning a lottery are often several 
million to one, so don't expect it to magically beat them. Hopefully, it'll help, but there's no guarantee.

I want to hear from you
Your comments and suggestions are an integral part of my design process. I appreciate and encourage 
your input on any of my products or services. You can contact me through any of the methods mentioned 
at the end of this document.

Lotto Tracker II License Agreement
Don’t forget to read the LTII License Agreement before using LTII. It is located in your LTII 
folder/directory.

Register now!
Please register your copy of LTII. This will entitle you to free and friendly :-) e-mail support, notification 
of upgrades and information on new products I've written. In addition, LTII can only be launched 20 
times until you register. Once I receive your registration, I'll supply you with a code that allows you to use 
the Register option in the program to brand it with your name as the authorized registered owner. So 
register today!
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Using this guide and LTII

This Users Guide takes a “window” approach… it describes each window and its use. You can use the 
Find feature in the “Navigation” menu (Cmd-F and Cmd-G) to look for references to specific subjects. 
Displaying of the Index can be toggled off and on by using the space bar and there are several other 
controls available (see the “About” menu option for this document in the Apple menu).

Concept of Lotto Tracker II
Its important to understand the concept behind LTII before you start using the program. Many lotto 
programs simply provide random numbers. Although LTII can produce random numbers (its “Quick 
Picks”), it relies on past results history to produce statistics which it bases the numbers it proposes upon. 
(called “Suggestions” in LTII). Results history is therefore a requirement for most of the functions in LTII 
to work. Up-to-date the results lets LTII track recent trends which it can use to base its suggestions.

LTII ships with the results of several lottos (each up to a specific date), however, there are two ways to get 
up-to-date results history information into the program. To get several months (or years) of results 
quickly, you can use the Import Results feature. LTII can import from several file types (see “Importing 
Results”). Keeping your results updated on a draw-by-draw basis is accomplished using the “Enter 
Results” feature. Here you manually type in the results for as many draws as you want.

Some terms used in LTII
LTII and this document use a few terms that need explaining:

Suggestions - the numbers LTII proposes based on result history statistics and your preference 
settings.

Prefs - ML/MR, Prefs - LL/MR, Prefs - ML/LR and Prefs - LL/LR - settings you can make for 
suggesting numbers that affect how LTII will use the statistics (see “Suggesting Numbers” in the 
Preferences window and “LTII’s Best Bet Pop-up” in the Suggestions window).

Prorated - a way of compiling statistics for lottos whose number of balls has changed over the span of 
results history in LTII’s database (see “Setting up a new lotto” in the New/Edit Lotto window).

Quick Pick - a randomly-generated set of numbers which are not based on the results history.

Importing - a way to get information from an external computer source into LTII’s database (see 
“Importing Results” in the Special Features section).

Exporting - a way to get information from LTII’s database into an external (non-LTII) computer file 
format (see “Exporting Results/Statistics” in the Special Features section).

Note on the Lotto Tracker II user-interface
LTII’s user-interface utilizes many windows and standard pull-down menus. The menu contents often 
change to reflect the context of the frontmost window and many of the options available as buttons in the 
various windows are also available via menu choices. The "Activities" menu, in particular, is very 
dynamic. In several cases there are shortcut keys (Cmd or Ctrl keys) that you can use to invoke a given 
option (eg. Cmd/Ctrl-Q will quit the program). When entering data in a window you can use various 
navigation keys to move from item to item. The recommended method is the Tab key which moves the 
focus to the next item in the window, and the Shift-Tab combination which moves the focus to the 
previous item. You can also use the Enter, Return and arrow keys, and, of course, the mouse.
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The About window

When you first launch LTII, you’ll see the About window.

It contains information about the copy of LTII you're using, including version number and date, license 
owner and serial number. It also contains a copyright warning which you should read and understand. The 
About window can also be accessed by choosing "About Lotto Tracker II" in the Apple menu (Mac) or the 
Utilities menu (Windows) and by clicking on the LTII logo in any window on which the logo is displayed. 
Clicking "OK" closes the About window.
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The Registration Reminder window

Until you register, LTII can only be launched 20 times. The Registration Reminder window monitors how 
many launches remain and allows you to do several things.

Registration Info button
Choosing this option displays information on the different ways you can register LTII. You can get a 
printer copy of this information by clicking "Print". Click "OK" to close the window.

Register button
This displays the Register window.

Here you enter the name of the license owner (usually your name) and a registration key to complete your 
registration. This key is provided by me on receipt of your registration. You can also access the Register 
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window from the "Utilities" menu. Choose "OK" to register or "Cancel" to leave the Register window 
without registering.

Continue button
Choose "Continue" to go on to the Lottos window.

Quit button
"Quit" exits the program.

Once you enter the registration information, the Registration Reminder window will no longer appear.

Thanks to all of you who have registered your copy of Lotto Tracker II.
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The Preferences window

You can access the Preferences window from the “Utilities” menu just about any time.

Suggesting numbers
This option lets you tell LTII to base its suggestions on the frequency that numbers have been drawn. If 
you think that numbers with high win frequencies are more likely to be drawn again, choose “more likely” 
(ML). If you feel that numbers which have the lowest win frequency are due, choose “less likely” (LL).

Where numbers have been drawn an equal number of times, if you feel that numbers which were drawn 
more recently are more likely to be drawn again, choose “more recently” (MR). If you feel that numbers 
which we last drawn at an earlier date are due, choose “less recently” (LR).

These settings are equivalent to the “Prefs - ML/MR”, “Prefs - LL/MR”, “Prefs - ML/LR” and “Prefs - 
LL/LR” choices in the Suggestions window pop-up.

Reports
LTII Lets you set preferences which affect what happens any time you choose the Print option in the file 
menu or click on a “Print” button. You choose the following settings for both print preview and actual 
printing:

• “Always” - LTII will either preview or print without any further prompting
• “Never” - LTII will never preview or print
• “Ask” - LTII will ask you to confirm whether to preview or print

Dates
With all the Y2K hoopla in the air, LTII offers some useful date options. LTII is Y2K compliant - it 
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understands years beyond 1999. Also, all dates display the full year value (eg. 1999, not 99 - at least until 
the year 9999!). When entering dates, it isn’t always necessary to enter the full 4-digit year.

Date format
You can set a global date format for LTII using the “Date format” pop-up. Choices available are 
“Month/Day/Year”, “Day/Month/Year” and “Year/Month/Day”. You can change the date setting at any 
time… it won’t adversly affect any of your data.

Auto Y2K dates
Use this option to tell LTII how to interpret the dates you type. If selected, the “Pivot year” is used as 
the change-over year from the 20th to the 21st century. This allows you to type just the last two digits 
of the year and have LTII automatically determine whether it should be preceeded by “19” or “20”.

Pivot year
If Auto Y2K dates is selected, the pivot year determines whether the year portion of any date you enter 
is in the 20th (19xx) or 21st (20xx) century. With a value of 50, typing any date with a year value of 
50 or greater will result in a 20th century date. Typing a date with a year value less than 50 will result 
in a 21st century date. The following table illustrates how the Auto Y2K dates settings affect the dates 
you type:

Auto Y2K Selected Pivot Year If you type LTII records
No - 12/31/99 12/31/1999
No - 01/01/00 01/01/1900
No - 12/31/1999 12/31/1999
No - 01/01/2000 01/01/2000
Yes 50 12/31/99 12/31/1999
Yes 50 01/01/00 01/01/2000
Yes 50 12/31/1999 12/31/1999
Yes 50 01/01/2000 01/01/2000
Yes 50 12/31/1949 12/31/2049

Notice in the last line that once Auto Y2K dates is selected, even typing the full four digit year is 
overridden by the Auto Y2K dates setting.

IMPORTANT NOTE:  
If you have Auto Y2K dates selected, there are a few dates for which LTII will return an error. One 
example is the 29th of February, 2000. In order to successfully enter a date like this, you must type the 
full 4-digit year (02/29/2000)… typing 02/29/00 will result in an error.
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The Lottos window

The Lottos window lists all lotto games that have been defined in LTII. The list includes the name of the 
game, the type of lotto (eg. 6/36 is a game with 36 numbers from which you choose 6), recorded draws 
(the total number of results entered into LTII), first draw number and date and last draw number and date. 
An asterisk (*) next to the draw type indicates a lotto which can take advantage of LTII's "prorated" 
feature. See "The New/Edit Lotto window" for an explanation of the prorated feature.

You can quickly jump to a specific lotto in the list by typing the first few characters of the name of the lotto 
(if this doesn't happen, click once anywhere in the list, then type).

The following options are available in the Activities menu any time the Lottos window is active:

There are five buttons along the bottom of the Lottos window:

Select button (Cmd/Ctrl-S)
The "Select" button is used to choose the highlighted lotto in the list to work with. You can also choose a 
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lotto by double-clicking it in the list. Once chosen, the Statistics window is displayed. See the section "The 
Statistics window" for more information on working in the Statistics window.

Edit button (Cmd/Ctrl-E)
The "Edit" button opens the highlighted lotto's definition in the Edit Lotto window. Here you can make 
changes to certain information about the lotto. See "The New/Edit Lotto window" for more information on 
working in the Edit Lotto window.

New button (Cmd/Ctrl-N)
The "New" button displays a blank New Lotto window where you can define a new lotto. See "The 
New/Edit Lotto window" for more information on working in the New Lotto window.

Delete button (Cmd/Ctrl-D)
The "Delete" button deletes the highlighted lotto and all its related result information. You are asked to 
confirm the deletion. Choose  "Yes" to delete the lotto or "No" to cancel the deletion.

Print button (Cmd/Ctrl-P)
Clicking the "Print" button or choosing “Print” from the File menu (Cmd/Ctrl-P) produces a report listing 
all the information in the Lottos window. You can view the report on screen (this requires a substantial 
amount of RAM), or send the report to your printer, or both. See "The Preferences window" for 
information on viewing reports on screen and printing reports. The Lottos report looks like this:

Quit button (Cmd/Ctrl-Q)
Choosing "Quit" exits the program.

10



The New/Edit Lotto window

The New/Edit Lotto window is displayed any time you choose "New" or "Edit" from the Lottos window.

The following option is available in the Activities menu any time the New/Edit Lotto window is active:

Setting up a new lotto

1. Enter a name for the new lotto. Be sure not to enter a name that's already been taken because LTII 
won't let you save the new lotto.

2. Choose the draw frequency from the pop-up. This is how often draws occur. If you don't see a 
frequency that matches the lotto you're defining, choose "Other". For twice-weekly drawings, 
enter the two draw days.

3. Enter the lowest and highest numbers for the lotto. The lowest number is usually 1, the highest 
must be at least 20 more than the lowest (eg. in a 6/36 lotto, the lowest is 1 and the highest is 36).

4. Enter the numbers in a draw. In a 6/36 lotto this would be 6.
5. (Optional) Enter any comments about the lotto in the Notes section. You can enter an unlimited 

amount of text here.
6. (Optional) Enter the starting draw numbers for each number in your new lotto by clicking on the 
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"Starting Draws" button. This is only necessary for lottos where the numbers in the lotto were 
increased at some point (eg. the Trinidad & Tobago lotto started off with 32 numbers and was 
subsequently increased to 36 numbers at draw number 105, therefore this lotto shows a starting 
draw number of 1 for numbers 1 to 32 and a starting number of 105 for draws 33 to 36). Unless 
you change the starting draw number for one or more numbers, LTII assumes that all numbers 
existed from draw number 1 (see “A note about the "Prorated" feature” below). Close the Starting 
Draws window to continue.

The following option is available in the Activities menu any time the Starting Draws window is active:

NOTE:  Clicking another LTII window while the Starting Draws window is open will automatically 
close the Starting Draws window

7. Click "Save" (or press Cmd/Ctrl-S). The new lotto will appear in the Lottos window list.

A note about the "Prorated" feature
Once you change the starting draw number for at least one number (as explained in 6 above) the "Prorated" 
feature becomes available. This feature modifies the win statistics for any number with a starting draw 
greater than 1 to act as if it had been around as long as all the other numbers. This results in more realistic 
behavior when generating number suggestions.

Editing and existing lotto
LTII will allow you to change certain information about a lotto such as its name, the lowest and highest 
numbers (with some restrictions), the starting draws, notes and, if no results have been entered or 
imported, the numbers in a draw.

1. Make any changes you require (see "Setting up a new lotto" for further information on specific 
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items).
2. Click "Save" to record your changes. If LTII spots any errors it will inform you so that you can 

correct them. It will also ask for confirmation if you change the lowest or highest numbers or the 
numbers in a draw.
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The Statistics window

Once you select a lotto from the lottos list, information about it is displayed in the Statistics window.

The following options are available in the Activities menu any time the Statistics window is active:

Recorded Draws
The total number of draw results recorded in LTII for this lotto.

Last Draw#
The draw number of the last recorded draw for this lotto.
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Last Draw Date
The draw date of the last recorded draw for this lotto.

From Draw # (version 1.5 and greater)
The draw number from which the current statistics have been compiled. You can set this to any value. If 
set to zero, LTII will set it to the lowest draw number in the recorded results for the selected lotto. If you 
set it to a higher value than the highest draw number in the recorded results, LTII will set it to the highest 
recorded draw number. You can use this to limit how far back into the results LTII goes when compiling 
statistics and suggesting numbers. Some people feel that going back more than a certain number of 
drawings is pointless. The value set is not activated until you click the "Redisplay" button.

HINT: Not sure what to set the From Draw # to? Try this: make sure you set the sort order to Ascending 
and click the “Last Draw” heading above the statistics list. This will sort the statistics by each number’s 
last draw number, with the earliest draw at the top. Note the draw number of the top row and enter this 
number as the From Draw # value. Press the “Redisplay” button. The statistics will now reflect the most 
recent range of draws for which each number has appeared at least once as a winner. (Have a look at the 
graph with this setting - the lowest number of wins will be 1).

Users of versions earlier than 1.5: These versions do not include the From Draw # feature. Although not 
as simple or fast as using the From Draw #, you can get the same effect by exporting your results, 
duplicating the exported file and then editing out the earlier draws using any text editor or word processing 
program. You can then import the edited resilts, producing a reduced results set - effectively the same as 
having the From Draw # feature.

To (Draw #)
The draw number to which the current statistics have been compiled. You can set this to any value. If set 
to zero, LTII will set it to the highest draw number in the recorded results for the selected lotto. If you set 
it to a higher value than the highest draw number in the recorded results, LTII will set it to the highest 
recorded draw number. You can use this to limit how far forward in the results LTII comes when 
compiling statistics and suggesting numbers. The value set is not activated until you click the "Redisplay" 
button.

Redisplay
Click the "Redisplay" button to recompute the statistics based on the draw from and to values that have 
been set. The draw from and to values will be modified automatically if they are out of range of the 
existing results.

Sort
Choose "Ascending" to sort the listed statistics in ascending sequence or "Descending" to sort them in 
descending sequence. The sort column heading is indicated in a darker grey than the other column 
headings. See “Column Headings” below.

Prorated
Check the "Prorated" check-box to have LTII use its prorated algorithm to recompute the statistics. Un-
check it to show actual statistic values. Only the "Wins"column is affected by the prorated check-box. If 
the prorated check-box is dimmed (not available), the lotto you’re working with does not require it . See 
step 6 in “Setting up a new lotto” for more information on the prorated feature.

Column Headings
Clicking on each of the six column headings (Number, Wins, Last Draw, Day, Month and Year) causes 
the statistics to be sorted on that column (in either ascending or descending sequence, based on the "Sort" 
choice made). Sorting on different statistics columns is helpful when visually analyzing statistics.
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The Statistics List
If you click once in the statistics list, you can quickly jump to a specific number by typing the number, 
Double-clicking a line in the statistics list will display a new "Results" window that lists all the draws from 
which that line was compiled. If you ever wanted to see all the draws where the number 5 was in the 
winning combination, double-click the statistics for number 5.

Winning Number for Draw #xxxx (version 1.5 and greater)
This is the winning number for the draw number displayed in the "To (Draw #)" field.

Statistics compiled from/to (version 1.5 and greater)
The date range of the displayed draws from and to. The from-date is the date of the draw number entered 
in the "From" field, the to-date is the date of the draw number entered in the "To" field.

Enter Results button (Cmd/Ctrl-R)
Displays a new window where you can enter new draw results and change previously entered results. See 
"The Results window" for more information on entering and updating results.

Graph button (Cmd/Ctrl-G)
Displays a graph of the current statistics in a new window. See "The Graph window" for more 
information about LTII graphs.

Number Suggestions button
Opens the Suggestions window where LTII suggests number combinations for you to use. See "The 
Suggestions window" for more information on using the suggestions window.

Names and Numbers button
Displays the Names and Numbers window where you can have LTII provide numbers based on names 
and phrases. See "The Names and Numbers window" for more information on using this window.

Check Numbers button
Displays the Check Numbers window where you can have LTII check a given number against multiple 
draws. See "The Check Numbers window" for more information on the Check Numbers window.

Check Suggestions button (version 1.5 and greater)
Opens the Check Suggestions window which lets you have LTII check its own suggestions against actual 
results. See "The Check Suggestions window" for more information on using this window.

Print button (Cmd/Ctrl-P)
The "Print" button produces a report listing the currently displayed statistics. See “The Preferences 
window” for information on print options that determine what happens when you choose to print. The 
Statistics report looks like this:
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Close button (Cmd/Ctrl-W)
Closes the Statistics window.
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The Results window

Choosing “Enter Results” from the Statistics window displays all recorded results for the current lotto in 
the Results window.

The following options are available in the Activities menu any time the Results window is active:

NOTE:  Clicking another LTII window while the Results window is open will automatically close the 
Results window

Draw No
This is the sequential draw number for each result and can be actual draw numbers for the particular lotto 
or LTII-generated sequential numbers. LTII will not allow duplicate draw numbers.

Date
The draw date for each result. Dates are displayed in the format you select in the Preferences window. All 
the dates in this user guide’s screen shots are displayed in day/month/year format but you can change the 
date format to suit your preferences (LTII is Year-2000 compliant).

No 1 to No x (number columns)
The winning numbers for each result. The number of columns displayed will depend on the type of lotto (a 
6/49 will display 6 columns, an 8/51 will display 8).
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*Sum*
The sum of the winning numbers for each result. Another useful statistic.

Entering new results
1. Make sure you’re on a new line. To get a new line choose “New Result” from the Activities menu 

(Cmd/Ctrl-N).  LTII will automatically fill in the draw number and date (except for lottos with a 
draw frequency of “Other”).

2. Enter the draw date if necessary. Remember to enter it in the format you’ve selected in the 
Preferences window. Single-digit day or month values such as 1 should be entered as 01. You can 
enter the year as either two or four digits (eg. 98 or 1998). See the Preferences window for more 
information on entering dates.

3. Enter the winning numbers. You can enter the numbers in any sequence.
4. Repeat the first three steps for each new result you’re entering.

Changing results
1. Locate the result you wish to change. You can have LTII search for a specific result by choosing 

“Find” from the Edit menu (Cmd/Ctrl-F).
2. Make any required changes.

Deleting results
1. Locate the result you wish to delete. You can have LTII search for a specific result by choosing 

“Find” from the Edit menu (Cmd/Ctrl-F).
2. click anywhere on the result and choose “Delete Result” from the Activities menu (Cmd/Ctrl-D).

Printing results
1. Choose “Print” from the File menu (Cmd/Ctrl-P). See “The Preferences window” for information 

on print options that determine what happens when you choose to print.
2. The Results report looks like this:
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Once you’re finished working with the results, close the Results window. LTII will validate the results. If 
an error is found a message will be displayed describing the error. Click OK. LTII will ask if to cancel any 
changes you made to the results. Choose “No” to redisplay the results (with the result in error selected), or 
choose “Yes” to cancel your changes.

Once all results have been validated, the statistics will be recomputed using the updated results and the 
Statistics window will be updated.

20



The Graph window

Choosing “Graph” from the Statistics window displays the LTII Graph window.

The following option is available in the Activities menu any time the Graph window is active:

Graphs are a great way to quickly view win trends and patterns. LTII graphs show the number of wins for 
each number based on the specified drawing range. The horizontal (x) axis displays the lotto numbers in 
the selected sequence. The vertical (y) axis displays the number of wins in ten increments. The red bars 
indicate the winning numbers for the “To draw” value.

Graphs share many of the same controls as the Statistics window. The major difference is that sorting is 
accomplished by using the “Sort by” pop-up which is equivalent to the Statistics window’s column 
headings.

For an explanation of the various controls refer to the corresponding controls in the Statistics window.
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The Suggestions window

Choosing “Number Suggestions” from the Statistics window displays the Suggestions window.

The Suggestions window displays number combinations for you to use based on the compiled statistics 
and LTII’s internal probability logic. You can influence the suggested numbers by changing the 
“Suggesting numbers” choices in the Preferences window (see “See Preferences window” for an 
explanation of these choices). Once the results for the “From”/”To” draw range aren’t changed, LTII will 
always suggest the same combinations (except for “Quick Picks” which are always regenerated). This 
allows it to check past suggestions against the actual result, displaying matched numbers in red.

The following option is available in the Activities menu any time the Suggestions window is active:

Date and Draw Number
The date and draw number for the displayed suggestions. These are determined by the draw “To” value. 
When projecting suggestions, for lottos with a draw frequency of “Other”, the words “Next Draw” are 
displayed instead of the next draw date.
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LTII’s Best Bet Pop-up
This pop-up is used to tell LTII which basis to use for suggesting numbers. There are six possible values:

LTII’s Best Bet
LTII will use its internal algorithm for suggesting numbers based on the currently compiled statistics. 
Entries made in the Preferences window have no effect on these suggestions.

Prefs - ML/MR
Preference settings “more likely” and “more recently” will be used in combination with LTII’s internal 
algorithm for suggesting numbers. See “The Preferences window” for more information.

Prefs - LL/MR
Preference settings “less likely” and “more recently” will be used in combination with LTII’s internal 
algorithm for suggesting numbers. See “The Preferences window” for more information.

Prefs - ML/LR
Preference settings “more likely” and “less recently” will be used in combination with LTII’s internal 
algorithm for suggesting numbers. See “The Preferences window” for more information.

Prefs - LL/LR
Preference settings “less likely” and “less recently” will be used in combination with LTII’s internal 
algorithm for suggesting numbers. See “The Preferences window” for more information.

Quick Pick
All the suggestions will be randomly-generated numbers which completely ignore the compiled 
statistics. This is like having the lotto teller machine pick the numbers for you. Quick picks are 
identified by green numbers and the letters “QP” to the right of the numbers.

Whichever basis you choose, the last row (G) will always be either a quick pick or the winning number 
for the draw indicated in the draw “To” box. LTII uses the following to determine what to put into row G:

• If the winning numbers for the draw number displayed at the top of the suggestions window HAS 
been entered into the results, LTII will display the winning numbers on row G (in purple).

• If the winning numbers for the draw number displayed at the top of the suggestions window has 
NOT been entered into the results, LTII will display a quick pick on row G (in green).

Selecting any of the “Prefs” options automatically changes the Preferences window settings to match.

NOTE:  Although LTII will never duplicate its suggestions on any row for a single pop-up choice, its 
possible that it will produce the same numbers for one or more rows when you change the suggestion 
basis using the pop-up. Therefore, remember to always check for duplicates if you select numbers using 
more than one pop-up choice.

Rows A to G
The suggested numbers are displayed in seven rows. Normally, numbers in rows A to F are displayed in 
black and row G in green (a “quick pick”). If the winning numbers for the displayed draw have already 
been entered into LTII’s results, any matching numbers in rows A to F are displayed in red and row G 
shows the winning numbers in purple.

From, To, Redisplay and Prorated controls
These are identical to the same controls in the Statistics window. For an explanation of them refer to the 
corresponding controls in the Statistics window. Use these controls to change the range of results used in 
compiling statistics used for suggesting numbers. Changing either the from, to or prorated values causes 
LTII to regenerate the statistics and the suggestions.
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Print button (Cmd/Ctrl-P)
The "Print" button produces a report listing the currently displayed suggestions. See “The Preferences 
window” for information on print options that determine what happens when you choose to print. The 
Suggestions report looks like this:

Close button (Cmd/Ctrl-W)
Closes the Suggestions window.

Remember, you don’t have to only depend on LTII’s suggestions for numbers to play. The Statistics, 
Graph and Check Suggestions windows allow you to view past history in a variety of ways. Playing with 
the settings in these windows allows you to see patterns which you can use to select your own numbers 
(which may be quite different from LTII’s suggestions).
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The Names and Numbers window

Choosing “Names and Numbers” from the Statistics window displays the Names and Numbers window.

This completely unscientific approach lets you enter words and phrases which LTII evaluates to a number 
within the range allowed by the currently selected lotto. Simply enter a name, number or phrase in each 
row and watch as LTII produces a number for you to use for the next lotto drawing. Within a given lotto, 
the same number will always be produced for a given word or phrase.

The following option is available in the Activities menu any time the Suggestions window is active:

Clear All
Clears all entries so you can start over and get a whole new number!

Close button (Cmd/Ctrl-W)
Closes the Names and Numbers window.
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The Check Numbers window (prior to version 1.6)

In LTII versions before version 1.6, choosing “Check Numbers” from the Statistics window displays the 
following Check Numbers window. If you’re using version 1.6 or greater, see the next section.

Use the Check Numbers window to have LTII check a given number combination on a draw-by draw 
basis. Enter the numbers to be checked, enter the draw number in the “Check Draw #” box and click 
“Check”. Matching numbers are underlined in red. OK, this is a lame feature. The next version of LTII 
will have a much improved version that lets you check as many number combinations as you like against 
as many drawings as you like… I promise.

The following option is available in the Activities menu any time the Suggestions window is active:

Close button (Cmd/Ctrl-W)
Closes the Check Numbers window.
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The Check Numbers window (version 1.6 and above)

LTII versions 1.6 and greater display the following Check Numbers window when you choose “Check 
Numbers” from the Statistics window. If you’re using an earlier version, see the previous section.

The Check Numbers window shows two panes. The left pane is used to store a list of numbers which you 
wish to check against results of one or more draws. The right pane displays the results of the check, listing 
all the numbers which matched numbers in the draw results checked.

The following option is available in the Activities menu any time the Check Numbers window is active:

Numbers to check
This pane displays a list of numbers you have entered (using the “Edit numbers” section below the list) in 
two columns, Row and Numbers. The Row column is an alphabetical reference generated by LTII. The 
Numbers column contains the numbers you have entered.
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Edit numbers
Enter the numbers you wish added to the list here. You can also change (edit) or delete existing numbers. 
As numbers are recorded they appear in the list above.

Matches
The Matches pane displays the results of checking your list of numbers against the draw(s) you specify. It 
includes three columns - Draw, Row and Matching Numbers. The Draw column shows the draw being 
checked for matching numbers. The Row column displays the row reference from the “Numbers to check” 
pane. The Matching Numbers column lists the numbers with matches in the winning combination.

Check from draw to draw
Use the “From” and “To” values to tell LTII which draw(s) to check

From
Specify the starting draw number to be checked.

To
Specify the ending draw number to be checked

Ignore
You can use this value to filter out check results with fewer winning number matches than whatever 
you specify. To see all matches, use a value of 1.

The total number of checks that will be done is displayed just above the “Check Now” and “Close” 
buttons.

NOTE:  As with checking Suggestions, performing a large number of checks can take a loooong time.
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The Check Suggestions window

Choosing “Check Suggestions” from the Statistics window displays the Check Suggestions window.

The Check Suggestions window allows you to specify criteria for LTII to use in checking how its 
suggestions stacked up against the actual results. There are a number of controls which let you determine 
both what will be checked as well as how many results it will display.

Base suggestions on

Statistics from draw #
This lets you specify the starting point for compiling statistics and is analogous to the “From Draw” 
number in the Statistics window.

Incremental check
You can have LTII repeatedly recompile statistics from a different starting point, each time checking all 
the combinations you specify in “Include suggestions for” and “Check only draws”.  To recompile 
statistics for every draw after the starting point, use a value of 1. To recompile for every 50th draw, 
use a value of 50. Note that using the incremental check feature can vastly increase the quantity of 
numbers that will be produced and checked, as well as the time it will take.

Prorated
If the lotto you’re working with can utilize the prorated feature, specify whether or not to use prorated 
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statistics.

Include suggestions for
Specify which LTII algorithms to produce and check suggestions for. See “The Suggestions window” and 
“The Preferences window” for more information on the meanings of the various choices.

Check only draws
Use the “From” and “To” values to tell LTII which draw(s) to check, using the “Base suggestions on” and 
“Include suggestions for” choices you made.

From
Specify the starting draw number to be checked.

To
Specify the ending draw number to be checked

Ignore
You can use this value to filter out suggestions with fewer winning number matches than whatever you 
specify. To see all suggestions, use a value of 0.

The total number of suggestions that will be produced and checked is displayed near the bottom of the 
window.

NOTE:  Checking a large number of suggestions can take a loooong time.

OK button
Clicking OK starts the checking process. A progress bar will be displayed while LTII generates and 
checks its suggestions.

You can cancel at any time by pressing the Esc key on your keyboard. Checking will continue for a few 
seconds then you’ll be asked to confirm canceling. Choose “No” to resume checking or “Yes” to cancel.

As long as you don’t cancel, you’ll eventually see the results appear in the “Suggestion Performance” 
window. See “The Suggestion Performance window” for an explanation of what it all means.

Cancel button
Closes the Check Suggestions window.
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The Suggestion Performance window

The results of checking suggestions appear in the Suggestion Performance window.

The following option is available in the Activities menu any time the Suggestion Performance window is 
active:

NOTE:  Clicking another LTII window while the Suggestion Performance window is open will 
automatically close the Suggestion Performance window

Gen Fr
The statistics compilation starting draw number used by LTII to generate the suggestion. A value of one 
means that statistics were compiled from the first draw.

Draw
The draw being checked.

Date
The date of the draw being checked.

Prefs
The LTII algorithm which produced the suggestion.

The next column is the corresponding Suggestions window row (A to F).
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Suggestions
The LTII number suggestion.

Matching Suggestions
The numbers in the LTII suggestion which matched winning numbers.

Matches
The quantity of matching numbers.

Printing suggestion performance
1. Choose “Print” from the File menu (Cmd/Ctrl-P). See “The Preferences window” for information 

on print options that determine what happens when you choose to print.
2. The Suggestions Performance report looks like this:
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Exporting suggestion performance
You can export the information in the Suggestion Performance to a TEXT or other file type so that you can 
do further analysis of the data in a database or spreadsheet program.

1. Choose “Export” and “Suggestion Performance” from the File menu.

2. Specify the type of file to export to and click “Continue”.

3. Enter a name for the new file and specify a location to save it. Choose “Save”

You can now open the exported file in another program such as a spreadsheet or database program.

Once you’re finished working with the Suggestion Performance window, close it to return to the Check 
Suggestions window.
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Special Features

Importing Results
You can import results into LTII from an external computer file. This can save you hours of time you 
might otherwise spend manually entering past drawing history into LTII’s Results window. The LTII web 
page located at <http://www.ggonsalves.com/lotto.html> has downloadable results for many lotto games. 
These results are all in a format which makes it easy to import them into LTII. This section provides 
instructions for importing specifically from these files as well as general instructions for importing from 
other TEXT files.

Importing from LTII web page downloadable files

1. Download and unstuff (Mac) or unzip (Windows) the file you wish to import.
2. If you haven't done so already, select a lotto in the Lottos window or define a new one which will 

utilize the imported results. If you define a new lotto, save the definition (see “The New/Edit Lotto 
window”). It will now appear in the list of lottos.

3. In the Lottos window, select the lotto. The Statistics window will appear.
4. Choose "Import Results" from the File menu.
5. In the Import window, choose the following:

File Type.....: TEXT - Tab Delimited
First Record..: Data record

Leave the other check boxes empty.
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6. Click "Continue" and locate and select the import (.txt) file. LTII displays the "Select Fields to 
Import" window.

7. Select the fields from the left pane (by double-clicking) in this order:
                DRAW_NO
                DRAW_DATE
                NO_1
                NO_2
                NO_3
                etc.

The selected fields will appear in the right pane in the order they were selected. Be sure to select all 
the "NO_" fields.

8. Click "OK". LTII will read the import file's contents and provide a preview list of the imported 
results. You can scroll through this list to verify that the data was imported correctly. At this point 
you can also change anything in the imported results, although its usually better to re-import the 
data with the correct specifications chosen.
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9. Once you're satisfied with the imported results (or if you spot errors you don't want to manually 
correct), close the preview window. LTII will verify the results just as if you'd entered them 
manually, stopping at the first error it finds. If it does find an error, a message identifying the error 
appears - choose "OK" to continue. You will be asked whether to cancel the import. Choose "Yes" 
to cancel or "No" to have LTII redisplay the preview window so that you can correct the error.

10. Once LTII verifies that no errors exist in the imported data, it asks whether to add the imported 
records to its database. Choose "Yes" to add them and complete the import process, or "No" to 
cancel the import.

11. If you choose "Yes", a progress bar appears as the imported results are added to the LTII database. 
Finally, a message indicates the number of result records that were imported. Choose "OK" to 
clear the message.

That's it. At this point your results will appear in LTII.

General instructions for importing from other TEXT files

Ideally, the results to be imported should be in ASCII TEXT format. If they are in Excel, you should 
save them as text before attempting to import.

1. Open the text file with any program that can open TEXT files. You just want to have a look at the 
contents of the file to find out the following:

a. The record/field layout (eg: draw date,draw number,no1,no2, etc.)
b. What type of field delimiters are used (the commas in the above example). Field delimiters are 

usually commas or tabs.
c. Whether the first line (record) contains data or headings.
d. The date format. Some (European) lottos use a different format (yy/mm/dd or dd/mm/yy).

Here's an example from the California Super Lotto:

drawing_date,drawing_nbr,nbr1,nbr2,nbr3,nbr4,nbr5,nbr6,
12/28/96,526,10,14,19,23,25,32,
12/25/96,525,13,23,24,29,30,48,
12/21/96,524,11,14,15,28,29,47,

In this example, the first record is a header. NOTE: The commas at the end of each line are not 
required and your file may not have them.

Once you have this information you're ready to import the file into LTII. Open LTII and do the 
following:

2. If you haven't done so already, select a lotto in the Lottos window or define a new one which will 
utilize the imported results. If you define a new lotto, save the definition (see “The New/Edit Lotto 
window”). It will now appear in the list of lottos.

3. In the Lottos window, select the lotto. The Statistics window will appear.
4. Choose Preferences from the Utilities menu and ensure that the date format selected matches the 

date format in the text file (see d. above).
5. Choose “Import Results” from the File menu. From the pop-up titled "Import results from file 

type:", select the type of file you're importing from. In the example above you would select 
"TEXT - Comma Delimited".

6. Select whether the first record is a Header or Data record. For my example you would choose 
Header Record.
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7. If the file from which you're importing does NOT contain draw numbers, check the "Generate 
Draw Numbers" box. You can then change the starting draw number to whatever you like. In my 
example you would not check this box since the file already has draw numbers.

8. Likewise, if your import file does not contain draw dates, check the "Generate Draw Dates" check 
box. In my example you would not check this box.

9. Click "Continue" and locate and select the import file. LTII displays the "Select Fields to Import" 
window.

10. Using the information you gathered by looking at your import file's contents (specifically item a. 
above), select the fields from the left pane (by double-clicking) in the order they appear in the 
import file. Selected fields will appear in the right pane in the order they are selected. This should 
match your import file's layout. The "SKIP" options are used for any fields in your import file 
which you want LTII to ignore. In my example you don't need to use these.
NOTE: Don't worry about any extra fields that may exist to the right of the last field you need to 
import. LTII will ignore them anyway. An example of this is the jackpot amount - some lotto 
results files include this type of information. Eg:

drawing_date,drawing_nbr,nbr1,nbr2,nbr3,nbr4,nbr5,nbr6,jackpot
12/28/96,526,10,14,19,23,25,32,25000000

11. Click "OK". LTII will read the import file's contents and provide a preview list of the imported 
results. You can scroll through this list to verify that the data was imported correctly. At this point 
you can also change anything in the imported results, although its usually better to re-import the 
data with the correct specifications chosen.

12. Once you're satisfied with the imported results (or if you spot errors you don't want to manually 
correct), close the preview window. LTII will verify the results just as if you'd entered them 
manually, stopping at the first error it finds. If it does find an error, a message identifying the error 
appears - choose "OK" to continue. You will be asked whether to cancel the import. Choose "Yes" 
to cancel or "No" to have LTII redisplay the preview window so that you can correct the error.

13. Once LTII verifies that no errors exist in the imported data, it asks whether to add the imported 
records to its database. Choose "Yes" to add them and complete the import process, or "No" to 
cancel the import.

14. If you choose "Yes", a progress bar appears as the imported results are added to the LTII database. 
Finally, a message indicates the number of result records that were imported. Choose "OK" to 
clear the message.

That's it. At this point your results will appear in LTII.

If you cannot get your results imported, I can do the import for you. You can contact me through any 
of the methods mentioned at the end of this document.
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Exporting Results
LTII lets you export the results for any of its lottos to TEXT and other format files. Exporting results is the 
exact opposite of importing results… LTII creates a new computer file containing the results in one of the 
following formats.

1. In the Lottos window, select the lotto for which you wish to export results. The Statistics window 
will appear.

2. Choose “Export” and “Results” from the File menu.

3. Select the file type to export to from the pop-up. The most common type is TEXT - Tab Delimited, 
which is the easiest format for importing into databases and spreadsheets. Click “Continue”.

4. Enter a name for the new file and specify a location to save it. Choose “Save”.

Exporting Statistics
You can also export the currently-displayed statistics to TEXT and other format files.

1. In the Lottos window, select the lotto for which you wish to export statistics. The Statistics 
window will appear.

2. Set the “From” and “To” draw values for the statistics you wish to export and click “Redisplay”.
3. Choose “Export” and “Statistics” from the File menu.
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3. Select the file type to export to from the pop-up. The most common type is TEXT - Tab Delimited, 
which is the easiest format for importing into databases and spreadsheets. Click “Continue”.

4. Enter a name for the new file and specify a location to save it. Choose “Save”.

Rebuilding Data Indexes
LTII uses something called an “index” for many of its data files to provide quick access to and sorting of 
its database. Although these indexes are dynamically maintained, its a good idea to regenerate them from 
time to time, especially if your computer ever loses power or is switched off while using LTII. This 
ensures that the indexes are always in sync with the data. If ever you get an error when using LTII, try 
running this option to see if it fixes the problem.

1. Make sure the Lottos window is active (topmost). The rebuild data indexes menu option is dimmed 
if any other window is active.

2. Choose “Rebuild Data Indexes” from the Utilities menu. You will be asked to confirm whether or 
not to proceed.

2. Choose “OK” to continue.

All LTII data indexes will be deleted and rebuilt.

Removing Deletions
When data is deleted in LTII, its database engine marks the record as deleted and you never see it again. 
However, the space occupied by the deleted record remains on your hard disk. Over time this can amount 
to wasted hard disk space and can adversely affect LTII’s performance as it skips over these deleted 
records. You can have LTII remove these deletions by rebuilding its database without them.

1. Make sure the Lottos window is active (topmost). The remove deletions menu option is dimmed if 
any other window is active.

2. Choose “Remove Deletions” from the Utilities menu. You will be asked to confirm whether or not 
to proceed.
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2. Choose “OK” to continue.

All deleted records in your LTII database will be permanently removed.

Resetting Window Locations
LTII remembers the positions of most of its windows. If you move a window, the next time you open that 
window it will appear where you last located it. If you ever want to reposition all windows at the centre of 
your display, choose “Reset Window Locations” from the Utilities menu.

1. Make sure the Lottos window is active (topmost). The reset window locations menu option is 
dimmed if any other window is active.

2. Choose “Reset Window Locations” from the Utilities menu. You will be asked to confirm whether 
or not to proceed.

2. Choose “OK” to continue.

The next time you open any LTII window it will appear in the centre of your display.

Registering LTII
Once your registration (and payment) has been received, you’ll be sent a “registration key”, a special 
number which you will use the “Register” menu option to enter. You can also click on the “Register” 
button in the Registration Reminder window to enter your registration key. See “The Registration 
Reminder window” for details.

Thanks to all of you who have registered your copy of Lotto Tracker II.
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Miscellaneous Information

Here are a few additional facts about LTII you might find useful or of interest.

Development platform
LTII was developed entirely in Microsoft FoxPro, version 2.6. No third-party add-ons were used. FoxPro 
was originally created by some pretty smart people at a company named Fox Software which was 
subsequently bought out by Microsoft some years ago (what else is new?). It is primarily a business-level 
relational database application development program based on the dBase model. All versions of LTII are 
first created on a Mac using FoxPro for Macintosh and then transferred to FoxPro for Windows where all 
the user-interface elements (screens) and reports are redone. Luckily for me, the program code itself 
remains almost 100% compatible between the two platforms.

LTII folder/directory structure
All LTII components reside in the LTII folder/directory. These include the application (Mac) or EXE (Win 
PC), a folder/directory named “Data” and some other stuff. All the lotto information is contained in the 
“Data” folder/directory. If I ever ask you to e-mail your LTII data folder to fix something for you, that’s 
the one to send (stuffed or zipped, of course).

Bonus numbers, wheels and checking your own numbers
I’ve got it all planned out in my head (and some of it on paper)… one of these days, a version of LTII will 
be released with the ability to handle bonus numbers (I think you’ll like how I plan to blend this into the 
current interface) and wheeling. For those of you who don’t know what wheeling is all about let’s just say 
that it lets you mix selected numbers up into various combinations which, hopefully, will improve your 
odds without breaking your wallet. Version 1.6 introduced a much better way to check your own numbers 
(not necessarily those suggested by LTII).

Additional games and updating results
LTII is designed for you to set up as many lottos as you like (well… 300) and then manually update them 
after each drawing using the “Enter Results” feature. From time to time I’ll add additional games to LTII 
(usually when I get a request for a particular game not yet included) and every so often I update the odd set 
of results. You should visit the LTII web page at:

<http://www.ggonsalves.com/lotto.html>

for up-to-date information about the world of LTII, including new version releases and updated results.

Technical Support
If you need technical support please have your LTII serial number and registered name readily available, as 
I cannot provide assistance without this information. I’ll also need:

• A description of your current hardware configuration, including computer model, printer make and 
model, system version and any other pertinent system information.

• A detailed description of the problem and what you may have done just prior to occurrence of the 
problem

If you call:

• If possible, be at your computer with all applicable hardware turned on and, if possible, have LTII 
loaded and ready to test.

• Be prepared to describe your problem in detail. If you have experienced system errors or 
unexpected quits, please make a note of any messages that may have been displayed.

• Have this manual readily available.
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Contact information
You can contact me for by one of the following methods (the preferred method is by e-mail):

by E-mail
• ggonsalves@wow.net

by Fax
• (868) 628-8151

by Phone
• (868) 622-9641

If no one can take your call, you can leave a recorded message with contact information (preferably 
an Internet e-mail address).

by Mail
• Gordon Gonsalves

110 Saddle Road,
Maraval
Trinidad & Tobago

Trademarks & Copyrights

Lotto Tracker II is a trademark of Gordon Gonsalves.
Lotto Tracker II is Copyright © 1997-2000 Gordon Gonsalves. All rights reserved.

All other copyrights and trademarks are held by their respective holders.
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